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Introduction 

Welcome to TheBrainÊ, your ultimate digital memory and no limits mind mapping 
software. Intelligence comes from the mindôs ability to think associativelyðthat is, 
to leap from thought to thought, building webs of greater and greater complexity, 
until new ideas are built. Associations are our inspirations. TheBrain allows you to 
organize your information in the same way, without limiting you to a pre-
determined file structure. In fact, with your digital brain there are no limits. You can 
create a small project-focused brain or grow your brain to hundreds of thousands 
of thoughts! 

Now you don't have to force any idea or project into a single folder. TheBrain 
organizes information as thoughts. Unlike folder directories and search lists, a 
ñthoughtò in your brain can have many connections and contexts. Moreover, 
TheBrain displays your thoughts by concept or project, linked according to how 
you think. Now you can get the big picture and discover information that might 

otherwise be overlooked.  

Thoughts contain relevant notes, web pages, and files. Brains can be synced for 
easy access from your desktop to TheBrain Cloud or your mobile devices. 

  

Figure 1. TheBrain Interface 

Thoughts are Information 

TheBrain thoughts can represent just about any type of information, including 
concepts, people, documents, spreadsheets, images, videos, shortcuts, and web 
pages. By letting you create links and associations between thoughts, TheBrain 
expands to become a visual interface that reflects the way you think. 
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Using simple click-and-drag techniques, youôll be able to create and navigate 
through networks of thoughts in a conceptual space unique to your work habits. 
When you begin using TheBrain, you will find that your computer becomes easier 
to useðfaster, more enjoyable, and less frustratingðhelping you use your time 
more efficiently. 

TheBrainôs Dynamic Graphical Interface 

TheBrain lets you create a simple, dynamic graphical map in which to input and 
navigate all your information. Your brain starts with a single thought, to which 
several other thoughts can be visually linked. These thoughts have their own 
links to other thoughts and, possibly, to each other. TheBrainôs flexible structure 
allows any thought to be linked to any other thought, so you are never more than 
a few steps away from the information you are seeking. Itôs simple to make 
connections between thoughts so that they reflect the connections you make in 
your mind. 

Cross Platform Accessibility  

Brain data is accessible from virtually any device with rich full-featured clients on 
Windows and macOS plus mobile clients for iOS and Android. Additionally, you 
can access your brain via a web browser by logging in at www.thebrain.com. 
TheBrainôs sync service keeps all your data backed up and synchronized over 

the cloud for seamless access. 

This user guide is focused on the Windows and macOS software. Please visit 
www.thebrain.com for information about the mobile clients.  

About this Guide 

The following icons are used throughout this guide to flag categories of 
information: 

 

This icon is used to identify notes. 

 

This icon is used to flag tips and suggestions. 

TheBrain is offered in two editionsðFree and Pro. Icons are used throughout the 
guide to flag features that are specific to the Pro edition. Features that are 
available in both editions are not designated with a special icon. 

 

This icon is used to indicate that the feature is available in the Pro edition only. 

http://www.thebrain.com/
http://www.thebrain.com/
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Because TheBrain works on Windows and macOS, OS-specific features are 
flagged with icons throughout the guide. Features that are available for both 
Operating Systems are not designated with a special icon. 

 

This icon is used to indicate that the information applies only to computers 
running macOS. 

 

This icon is used to indicate that the information applies only to computers 
running Windows. 

In addition: 

Labels Names of buttons, menus, commands, keys, and icons appear in this font 
throughout the guide in order to stand out. 

Note to macOS Users 

 

Right-clicking: Most features in TheBrain can be accessed with just a single 
click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-
clicking. On a Macintosh, many systems do not have a right mouse button. For 
trackpad users, click or tap with two fingers. Alternatively, hold down the 
Control key while you click. Note that many mice can be set up to interpret 
clicks on each side of the main button differently so that Control-clicking is not 
necessary. To enable this, alter the Mouse settings in the System Preferences 
area of your Mac. Select ñSecondary Buttonò for the right side of the mouse. 

Ctrl key: Some features are accessed by clicking while holding down the Ctrl 
key on Windows. For macOS, use the Command key. 

 

 

Here is a list of working definitions for the basic terms used throughout TheBrain.  

Brain A collection of associated thoughts, each of which can have 
content. You can create multiple brains. 

Thought The topics that you link together in your brain are called 
thoughts and are the basic unit of a brain. A thought can 
represent anything you want it to. It can include an icon, notes, 
and one or more attachments (such as files and web sites) or it 
can have no content at all and simply act as a subject heading 
or organizer. Minimally, a thought has a name. 
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Plex The visible, graphical portion of your brain that displays your 

thoughts. 

Content Area The portion of TheBrain window that displays content that can 
be associated with the active thought or link. Types of content 
include notes, attachments (such as worksheets, presentations, 
documents, videos, and images), links, URLs, and events. The 
Content Area also displays and provides quick access to 
related thoughts. 

 

 

Clicking any thought or link in the Plex displays its associated content in the 
Content Area.  

 

 
Figure 2. TheBrain Plex and Content Area 

Active 
Thought 

The active thought appears in the center of the Plex and is 
the current focus. Any items attached to the thought, like 
notes, files, links, and events appear in the Content Area.  

 

Figure 3. The Different Ways a Thought Can Appear 

JK
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As shown below, when you click a thought, it moves to the center of the Plex and 

it becomes the active thought.  

 
Figure 4. Activating a Thought 

Thought 
Relationships 

A thought is said to be a ñparent thought,ò ñchild thought,ò 
ñsibling thought,ò or ñjump thoughtò based on its relationship 
to other thoughts with which it is linked.  

In your own life, you may be someoneôs parent, and 
someoneôs child, and someoneôs sibling, and someoneôs 
peer, advisor, or colleague. So, who are you? The answer to 
that question is relativeðit depends on the circumstances 

and what hat youôre wearing at the moment.  
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Figure 5. Relationships are Relative to You 

The same applies to thoughts. The relationships between 
thoughts are displayed automatically, based on which thought 
is active at the moment.  

 

Whether a thought is a parent, child, or sibling depends on its 

current relationship to the active thought.  

 

Figure 6. Thought Relationships are Relative to the Active Thought 

Child 
Thought 

Child thoughts are subtopics of the active thought. They 
appear in the ñchild zone,ò below the active thought. In the 
picture above, the active thought ñHobbiesò has seven child 
thoughts. 
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Parent 
Thought 

Parent thoughts represent superordinate topics of the active 
thought. They appear in the parent zone, above the active 
thought. 

Sibling 
Thought 

Sibling thoughts share a parent with the active thought. They 
appear in the sibling zone, to the right of the active thought. 
In the picture above, ñFamily,ò ñFood,ò ñHealth and Fitness,ò 
ñHome Projects,ò ñMy Passion,ò ñMy Pet,ò and ñPersonal 
Financeò are siblings of ñHobbiesò because they are all 
children of ñPersonal Life.ò Sibling thoughts will not be 
displayed if there are more than 50 parents to show in the 
current plex. 

Jump 
Thought 

Jump thoughts are related to the active thought but are 
neither child nor parent topics. They appear in the jump zone 
to the left of the active thought. Jump thoughts have an 
ñequal weightò relationship with the thought to which they are 
related. For example, as shown above, ñHobbiesò has the 
various hobbies ñArt and Culture,ò ñGardening,ò ñMusic,ò 
ñSnorkeling and Diving,ò ñSports,ò ñTechnology,ò and ñWhat 
Iôm Reading Nowò linked as child thoughts since they are 
types of hobbies. ñBudgetò affects the amount of resources 
available to spend on the various hobbies and so it is closely 
related, but it is not a hobby itself. Therefore, it makes a 
perfect jump thoughtˈrelated, but not part of the main 
thought grouping. 

Gate Thoughts in the Plex have three circular ñgates,ò each of 
which is used to link a specific type of relation: The parent 
gate is above a thought, the child gate is below it, and the 
jump gate is to the left or right of it. A gate is hollow when 
there are no links attached to it and solid when one or more 
links are attached. Solid gates in a contrasting color have 
links to thoughts that are not currently showing in the Plex. 
The color of gates is based on the current color scheme. 
When you point at a gate, a highlighting circle appears 

around it. 

Link A link is the line that connects two thoughts. When used as a 
verb, to ñlinkò is the act of connecting thoughts to establish 
close relationships. Links can also show direction to help you 

visualize relationships. 
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Figure 7. Thought Gates 

Installing TheBrain and Creating a Brain Account 

The first time you download and install TheBrain, youôll be prompted to log in or 
create an account if you donôt already have one. The log-in window provides the 
ability to create a new account or log in to an existing account. 

 

Figure 8. TheBrain Log-in Window 

Here are the fields to complete if youôre creating a new account: 
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Figure 9. Creating a New Account 

After you click the Create Account button, TheBrain will send an email to the 
address you specified.  

 

Check for a message from no-reply@thebrain.com. Make sure to check your 
spam folder if you donôt receive the message promptly.  

When you open the message, you will see a green Activate Brain Account link. 

After you click the link, youôll see a notice confirming your success. 
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Figure 10. Activating a New Account 

Now you can return to TheBrain and log in. 
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Figure 11. Welcome to TheBrain 

Click ñCreate a Quick-Start Brainò and follow the directions on the screen to enter a 
personalized name for this brain. The Quick-Start brain is actually a dynamic 
resource for learning more about using your brains and youôll find a wealth of 
useful information in it. Click any of the links to see what is displayed.  

You can always create a new Quick-Start brain by selecting the Create a Quick-
Start Brain command on TheBrain Help menu. 

Opening Older Brains 

When youôre looking at old and new brain files, note that brains created in 
TheBrain 7 or 8 have filename extensions of .brain. Brains created in some earlier 
versions have a .brn filename extension.  

 

To open a .brn file that you created in a version older than TheBrain 8, first 
open it using TheBrain 8 and then import the resulting brain in TheBrain 12, as 

described in the steps below. 
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Any older Brain must be opened in TheBrain version 8.0.2.2 before it can be 
imported into TheBrain 12. Version 8.0.2.2 can still be downloaded and 
installed from TheBrain website at 

https://www.thebrain.com/products/thebrain/oldversions . 

To open a brain that you created in TheBrain 8: 

1. Open TheBrain. 

2. Click the File menu, then click the Import command. 

 
All dialog boxes can also be navigated via the Tab and Arrow keys.  

 

 

Figure 12. Import Box for Opening an Older Brain 

3. Click the Select File button, navigate to the brain of your choice, then click 
the Open button when the file is selected. You will see a running progress 
report. 

4. When TheBrain has finished converting, you will see a ñConversion 

completeò message as shown below. Click the Import button.   

https://www.thebrain.com/products/thebrain/oldversions
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Figure 13. Import Conversion Progress 

5. When TheBrain has finished importing, you will see the following dialog 
box. Click the Open button to open the brain you just imported in a new tab 
of TheBrain window. 

 

Figure 14. Open the Imported Brain in a New Tab 

Suggestions for Transitioning to Your New Brain 

Here are some tips for establishing a happy relationship with your brain: 

Begin by taking yourself on the guided tour provided in the next section of this 
guide. As you exit the tour, youôll already have hands-on skills for getting your 
brain up and running quickly and easily. You may also want to attend one of 
TheBrainôs free online seminars on getting startedˈTheBrain 101. To learn more 
about TheBrain 101, go to http://www.thebrain.com/101. 

Avoid ñconvertingò to a Brain-only environment all at once. Make the transition on 
a file-by-file basis so that every piece of information your brain contains will be 
useful. 

http://www.thebrain.com/101
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Build your brain as you goðassociating thoughts as they occur naturally. 

Avoid the temptation to move large folders into your brain. TheBrain can handle 
this, but your brain will be cluttered with thoughts you may not need. 

Remember that your first brain doesnôt need to be your only brain or your last 
brain. Experiment! Create a brain just for fun, to try out the possibilitiesðgive 

yourself room to stretch and explore. Your brain is waiting! 

 

Questions? Contact TheBrain Support Team right from within TheBrain app by 
choosing Contact Us from the Help menu in TheBrain toolbar. 
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A Guided Tour of TheBrain 

The best way to build your comfort level with your brain is to build one yourselfð
with your very own hands. This guided tour will walk you through the basics, 
pointing out items of interest along the way. Thereôs no need to take notes and 
youôll never get left behind, because youôll be going at the most strategic paceð
your own.  

  

During this tour, youôll be asked to enter specific information to make it easier 
to refer to items and areas as the tour proceeds. Naturally, when youôre on 
your own, youôll use your own ideas to create brains that reflect your thinking. 

Here are the sign posts youôll see along the way:  

 Enter hereðthe startup action for this phase of your guided tour 

 Point of interestðtake out your virtual camera 

 Tipðwhere you can find more details about this step of your guided tour 

 Take fiveðthis is a good place to take a break if you want one 

 Exit hereðthis marks the end of your guided tour 

Letôs go! 

Part 1: Start Up and Explore TheBrain Window 

Itinerary: Youôll start up TheBrain, create a new brain, and tour through the 
components of the Brain window. 

 Start up TheBrain, unless itôs already running. You can select TheBrain from the 
Start menu or the desktop icon. On macOS, TheBrain app can be found in the 
Applications directory. 
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Figure 15. Starting TheBrain 

Log in to your Brain account. This enables integration with any subscriptions you 

may have.  

 

Figure 16. Logging In to TheBrain 

1. Click the File menu in the menu bar at the top of the window on the 
welcome screen (or click the File menu, then click the Create Brain 
command). 
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Figure 17. ñCreate Brainò Command 

2. In the empty field, type: Tour 

 

Figure 18. ñCreate Brainò Dialog Box 

3. Press the Enter key or click the OK button to finish creating your new brain. 
It will appear in a new tab named ñTour.ò  Your screen should look similar to 
the one below. Note that you can minimize, maximize, or restore TheBrain 

window using standard Windowsô or macOS techniques. 
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Figure 19. New Brain in the Plex 

TheBrain creates your first thought for you. It has the same name as your brain 
(which you can change later if you want to). Since itôs the only thought, itôs also 
the ñactive thoughtòðthe thought thatôs currently selected. 

4. Take a few minutes to click some of the Brain Themes to see how the 
background of the Plex changes. Then click the Theme named ñ- Light Blue 
Defaultò to select it. Click the ñXò or press the Esc key to close the Brain 
Theme box. 

 

Figure 20. New Brain with ñLight Blue Defaultò Theme Selected 

  

You can always return to the Brain Themes box by right-clicking within any 
blank area of the Plex and selecting Brain Theme. 
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 The Brain Toolbar 

 

Figure 21. TheBrain Toolbar 

1. Point at each one of the buttons in the Brain toolbar so that you see a brief 
explanation in the pop-up tool tip. 

  

Note that since your Brain has only a single thought so far, some of the toolbar 
options are currently disabled. 

 The Brainôs Content Area 

 

Figure 22. A Note in the Content Area 
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1. The thought name automatically appears as a heading at the top of the 
Content Areaðyou can always change the heading. For now, click in the 
empty white space of the Content Area just below ñTour,ò then type: My 
tour of TheBrain. Youôve just created your first note, which is associated 
with the ñactive thoughtòðTour. 

  

Notes are saved automatically and always stay associated with the active 

thought, even when you activate other thoughts or close your brain. 

2. Experiment with any of the buttons in the Content Area toolbar if you want a 
quick peek at some of the functionality.  

 Tip: See the section beginning on page 169 for details about working with the 
Content Area. 

Part 2: Creating Thoughts 

Itinerary: Youôll create a single thought, multiple thoughts, a thought from an 
existing file, and a thought ñpin,ò and modify the relationship between two 
thoughts. 

 Your Tour brain should be on the screen, as you left it in Part 1. 

1. The three small circles in the border around the Tour thought are called 
ñgates.ò The bottom circle is called the child gate because it provides a 
gateway towards creating a child thought. Drag the mouse from the child 
gate down a short distance, then release the mouse button. The Create 
Child dialog box will open. 

 Tip: If you prefer not to drag the mouse to create a thought, right-click the Tour 
thought and then click the Create Child command in the context menu. This can 

also be done with a Keyboard Shortcut. 

 
Figure 23. Dragging from the Child Gate 
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The context menu for the active thought can also be accessed by clicking on 
the Menu key on a Windows keyboard. 

2. In the empty field, type: TB Buddies 

 This thought will organize thoughts about people youôre going to talk to 
about how they use TheBrain, so you can share experiences. 

3. Press the Enter key. A larger circle appears around a new thought for a 
few seconds, highlighting it for easy visibility. Your Tour thought now has a 

child thought named ñTB Buddiesò (short for ñTheBrain Buddiesò). 

 Creating Multiple Thoughts at Once 

You can create more than one thought at a time by typing a semicolon to 
separate each thought. 

1. Create four new child thoughts for Tour, all at the same time. To begin, 
drag from Tourôs child gate down a bit, then release the mouse button. 

2. In the empty field, type: Tips; Reminders; To-Do; New Brain Ideas 

 
Figure 24. Create Multiple Thoughts at Once 

 Tip: The semicolon (;) between each thought name tells TheBrain that these are 
separate thoughts. Typing a space after each semi-colon is optional. 

3. Press the Enter key.  
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Note that the new thoughts are arranged in alphabetical order. To change the 
order of thoughts, right click in the background and select Arrange Thoughts 
byé From here, you can arrange thoughts by Name, Type, and Date Modified, 
Created or Activated in Latest or Oldest orders. Thought sorting disregards 
articles such as A, An and The. 

 

 Create a Thought by Dragging and Dropping an Existing File 

You can create a thought by dragging a file from the desktop or from your file 
manager (such as File Explorer on Windows or Finder on a Mac). The new 
thought will have the same name as the file (minus its extension) and it will 
automatically have the file as an attachment. It will become a child of the active 

thought. Youôll learn more about attachments in the next part of this tour. 

1. Choose any file, from your desktop or from any other location. Your original 
file will not be affectedˈby default, drag and drop creates a copy of the file. 

2. Size the TheBrain window so that you can also see either the portion of the 
desktop containing the file youôre going to use or the window in which the 
file is listed.  

3. Drag the file into the Plex. Thereôs no need to drag it to a specific thought. 

 

Figure 25. File Dragged into Plex Becomes a Child Thought of the Active Thought 

 The new thought will appear in the Plex and it will include an icon that 
represents the type of file. Any time you click this icon in the Plex, the 
related file will open. 
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 Thought Pins 

 

Figure 26. Thought Pins in a Brain 

The area at the top of the Plex, just below the Brain toolbar functions like a 
bulletin board on which you can ñpinò thoughts you want to keep at your 
fingertips. These quick-access shortcuts to thoughts are called ñpins.ò No matter 
where you are in the Plex, the pins remain visible.  

1. Right-click the thought named ñReminders,ò then click Create Pin on the 

context menu. 

 
Figure 27. Creating a Pin 

2. Click any other thought in the Plex. When you want to return to the 
Reminders thought, click the Reminders pin to get there instantly. 
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 Relationship Changes 

1. Create a new child of Tour named ñExperiments.ò (Drag from Tourôs child 
gate down a bit, type: Experiments and then press the Enter key.) Then 

click the Tour thought to make it active. 

2. Now youôve decided that the Experiments thought should really have an 
equal relationship with Tour, and not be one of its childrenðbecause youôll 
use experimenting as much as touring to develop your Brain skills.  

 Drag Experiments up to the left side of the Plex so that it is level with Tour, 
then release the mouse button. 

 

Figure 28. Dragging a Thought to Change its Relationship 

 Tip: See the section beginning on page 103 for details about changing thought 
relationships. 

 This is a good place for a break if youôd like to take one. You can leave your 
brain open or close the Brain window. Just start up TheBrain again when youôre 
ready to continue. 
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Part 3: Find, Add Attachments, Link, and Delete Thoughts 

Itinerary: Youôll find thoughts, add an attachment to a thought, add a web page 
to a thought, use a thought to open an application, link some thoughts, and 
delete a thought. 

 Your Tour brain should be on the screen, as you left it in Part 2. Youôll begin by 
creating a few more thoughts for a little more scenery along the way. 

1. Create four new child thoughts under TB Buddies: John; Jill; Fred; Ann 
(Drag from TB Buddiesô child gate, then type each name, separated by a 

semicolon, then press the Enter key.) 

 

Figure 29. Four New Thoughts 

2. Click TB Buddies to make it the active thought. It should be in the middle of 
the Plex. 

3. Enter a note for TB Buddies: We should compare brains sometime 

4. Point the mouse at the Tour thought and notice how the note you just 
entered for TB Buddies is still in the Content Area.  

5. Click the Reminders pin at the top of the Plex to go quickly to your 
Reminders thought. Notice that the Content Area only has the thought 

name heading, since you havenôt created content for that thought yet. 

 Instant Activation  

ñInstant Activationò is a Brain feature that lets you quickly find a thought by typing 
a few letters, and choosing from a list of ñhits.ò After you click the thought of your 
choice, that thought is automatically activated. 



 A Guided Tour of TheBrain 

TheBrain 12 User Guide 26 

Say youôre ready to work with Fredôs thoughtðyou want to add an attachment to 
it. With such a small brain, you could click around and find it pretty quickly, or you 
could speed things up: 

1. Click in the Search box in the top-right area of the window and type: f 

 

Figure 30. Instant Activation 

 Because you only have one thought that begins with the letter ñf,ò it is found 
instantly. If other thoughts begin with the same letter, you will see them in 
the results as well. The more characters you type, the more finely-tuned 

your search will become. 

2. Click on ñFredò in the Search box below Thoughts, Links, and Events. Fred 
will be activated. 

3. Type the letter ñjò in the Search box to search for Jill. Notice that the two 
thoughts beginning with the letter ñjò appear in the list. Click on Jill to 
activate this thought. 

 Tip: See the Searching a Brain section beginning on page 48 for details about 
more complex searching and the Navigating Your Brain section on page 39 for 
more on cruising around your brain.  

 Attachments 

1. Back to Fred. Activate Fred by clicking his thought in the Plex. 

2. Click the Attach button in the Content Area toolbar. As you see below, you 
can add many kinds of attachments. 
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Figure 31. Add an Attachment 

3. You can add an existing file or you can create a new one. For now, select 

an existing file on your computer. To do so, click Link to File in the list. 

4. Navigate to any file on your computer, then click the Open button to attach 
it to the active thought. If you attach a picture file, youôll see the image itself 
in the Content Area. Otherwise, youôll see the name and description of the 

file.  

 

Figure 32. After Attaching a File 

5. When you return to the Content Area, youôll see a link to the file you 
attached. You can click on it whenever Fred is active to access and open 
the file. You might use this function to add a file youôre collaborating on, or 
a worksheet with data for a project youôre completing together. 
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 Web Page Thoughts 

1. Activate the John thought. 

2. Open your Web browser and navigate to a web page of your choice. 

3. Arrange the browser window and the Brain window so that you can see at 
least part of both of them. 

4. Drag from the address bar icon in your browser to an empty area of the 
Plex, then release the mouse button. 

 

Figure 33. Inserting a Web Page as an Attachment 

The web page will be added as a child thought of John. When you click either the 
thoughtôs icon in the Plex or the link in the Content Area, the web page will 
launch in TheBrainôs built-in browser in the Content Area. 

Tip: If you want to add the web page to an existing thought instead of creating a 
new child thought, drop the web page on top of the thought. 
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 Creating Attachments from a Thought 

1. Activate the New Brain Ideas thought by typing an ñnò in the Search box 
and then clicking on ñNew Brain Ideasò in the list. 

2. Click the Attach button in the Content Area toolbar, then click Add File 
from Template. 

3. Click Microsoft Excel Worksheet (assuming this application is installed on 
your computerðif not, select any other application in the list). The new 

document will be named ñNew Brain Ideas,ò matching the active thought. 

 

TheBrain automatically detects file types for many applications that you may 
have installed on your computer and populates the list of available files to 
create. You can also add templates for any file that youôd like to use as a basis 
for new files yourself. 

Á Click the Attach button, select Template Help, then click the Yes button to 
open the folder where templates are stored. Copy empty files of the types 
you want to be able to create from within TheBrain into the folder.  

Á When you are done, click the Attach button again and chose one of the 
templates you added. User Templates will appear in a list directly above 

all System Templates. 

Once you select a file type, two things will happen:  

Á First, a new file will be created and added to the thought (in this example, a 
Microsoft Excel document named ñNew Brain Ideasò). 

Á Second, the file will be automatically opened so that you can work on it (in 
this case, starting Microsoft Excel).  

After you add content to the document and save it, it will be saved internally 
within your brain. When you activate the same thought, the document can be 

opened again by clicking it in the Content Area. 

4. Close the new document before moving on to the next section. 

 Linking Thoughts 

One of the most powerful features of TheBrain is the ability to connect thoughts 
to each other. Remember, you can connect any thought to any other thought. For 
example, say one of your TB Buddies, Ann, is full of ideas on how to use your 
brain. You might want to link her to the New Brain Ideas thought. 

1. Activate the New Brain Ideas thought (if it isnôt still active). 
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2. Drag from the jump gate on the left side of New Brain Ideas as if you are 

going to create a new jump thought and release the mouse button. 

 

3. Type the first few letters of the thought you want to connect (Ann) in the 
Create Jump dialog box. Notice that the existing thought is displayed in the 
list below. 

 

4. Either double-click on Ann in the list of found results or click Ann once, then 
press the Enter key. 

 

Figure 34. Jump Thought Linked to an Existing Thought 

Now that Ann is connected to New Brain Ideas, whenever you look at this 
thought, her thought will be just a click away. Also, when you are at Annôs 

thought, the New Brain Ideas thought will be conveniently available. 
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There are many ways to link existing thoughts. The method above is convenient 
when the thoughts you want to connect are not both visible. If the thoughts are 
both visible; you can simply draw the link between the two, starting from either 
one of the thoughtsô gates. Both the Past Thought List below the Plex and the 
pins can be used for linking thoughts visually. When you connect two thoughts 
visually, the resulting relationship will be determined by which gate you selected 
to start the linkingˈit does not matter where you release the mouse button over 
the destination thought. 

 Forgetting and Deleting Thoughts 

If youôve entered a thought in error or you simply donôt need to keep it around 
anymore, you can easily remove it from your brain. TheBrain offers two ways to 
remove thoughtsˈforgetting and deleting. When a thought is forgotten, it can be 
remembered later if need be; however, deleting is permanent. 

Letôs forget the Jill thought. 

1. Activate TB Buddies. 

2. Right-click the Jill thought. 

3. Click the Forget ñJillò command on the context menu. 

Jill disappears from the display. Now, if you want to show Jill again, turn on 
Forgotten Thoughts: 

Á Click the Options menu, then click Show Forgotten Thoughts. 

Any forgotten thoughts will appear faded. 

 

Figure 35. Forgotten Thoughts 



 A Guided Tour of TheBrain 

TheBrain 12 User Guide 32 

A message above the Plex reminds you that forgotten thoughts are showing. You 
can permanently delete thoughts or remember them. This can be done 
individually or all at the same time, which is explained in the Forgetting and 
Deleting Thoughts section on page 116. To turn off the display of forgotten 
thoughts, simply click the X button next to View Report or click the Show 

Forgotten Thoughts command in the Options menu to toggle it off. 

 Tip: If you want to permanently delete a thought without first forgetting it, hold 
down the Shift key (for Windows)/Alt key (for Mac) as you right-click on it and 
then select the Delete command. 

Concluding Your Tour 

If you click the Home button in the Brain toolbar, your brain should look 

something like this: 

 

Figure 36. Completed Tour 

Where to go from here? You can stay and experiment more with your Tour 
brain, begin reviewing sections of interest throughout this guide, open the Quick-
Start brain (click on Help and select Open a Quick-Start Brainé) , or dive into 
creating your own brain. You may want to glance at some of the example brains 
at https://thebrain.com/apps for more ideasðbut you probably already have 

plenty of your own! 

  

https://thebrain.com/apps
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 Tip: If you are ready to dive into beginning your own brain, start by creating a few 
thoughts for broad categories before you go to the detail level. For example, if 
your name is Ed, ñEdôs Brainò might be the name of your brain (and your first 

thought) and its first children might be Work, Family, Hobbies, and Friends. 

 This concludes your guided tourð-thanks for coming along! 
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Understanding Thought Relationships 

There are no rules governing the relationships between thoughtsðwhatever 
makes sense to you is the way your brain ought to be organized. The three 
primary relationship typesˈchild, parent, and jumpˈcan be used to express 
different types of relationships. Sibling is a relationship that is derived from 
child/parent relationships.  

The examples in this section can help you understand the variety of relationships 
and how they are used. The core concepts behind each type of relationship are 
as follows: 

Á Children: Child thoughts are usually used to link more specific information or 

information that represents a sub-category. 

Á Parents: Thoughts linked as Parents are usually used to link more general 
information. Parents can also be thought of as higher-level categories to 
classify groups of information. They serve to indirectly connect their child 

thoughts as siblings. 

Á Jumps: Jump thoughts are usually used to link two pieces of information that 
are exclusively related, meaning that the two items are related to each other 
but neither represents a group that the other is a part of. 

Letôs move on to an example to explore these relationship types. Imagine that 
you are the owner of a company and you are reviewing personnel files. Each 
employee has a file. You decide it makes sense to organize your employees by 
department. Your brain is called My Brain. From My Brain, you create a child 
thought called My Company (see Figure 37). My Brain is now My Companyôs 
parent thought. You create four child thoughts from My Companyð
Manufacturing, Sales, Service, and Billing. These departments are sibling 
thoughts of each other. 
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Figure 37. Sample Brain 

Now you go to each department and create more child thoughts, one for each 
employee of the department. If an employee splits time between two 
departments, you can make him a child thought of both departmentsðheôll 
appear in both and you wonôt have to duplicate his thought. In this example, Bob 
is a child thought of both Manufacturing and Sales (see Figure 38). This is one of 
the most powerful features of TheBrainðhaving one thought under more than 
one heading. 
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Figure 38. Child Thought with Two Parents 

If you own more than one company, but have one accountant for all of them, you 
might want to create a thought called Accountant and link it as a jump thought to 
each company, as shown below.  

  

Figure 39. Jump Thoughts to the Active Thought 
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Imagine that Joeôs company has just purchased one of your companies. Since 
Joeôs company now owns this company, Joeôs Company becomes a parent (see 
below). 

 

 

Figure 40. New Parent Thought 

Because Joe wants to avoid a conflict of interest, the acquired company (My 
Other Company) no longer uses the same accountant. So its jump gate is hollow, 

while its siblingôs jump gate (My Company) maintains that link and is filled. 

As you use TheBrain, you will develop a sense of the types of relationships you 
wish to make between thoughts. It is always easy to change relationships by 
adding and removing links (see Changing Relationships Using Drag and Drop on 

page 123). 

Families of Thoughts 

It is tempting to view thought relationships as families, and indeed these different 
parts of your brain are types of families, with their ancestry visually spread before 
you, represented by subjects and categories. But unlike human families, a child 
thought can be a parent of one of its siblings and a thought can have more than 
two parents. 

The complex relationships you can form in TheBrain are the source of its power. 

Letôs consider sibling thoughts that also share a parent/child relationship. 
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Letôs say you are studying philosophy. You might have a thought called 
Philosophy. Individual philosophers such as Plato and Aristotle could be child 
thoughts of Philosophy. Each of these siblings, in turn, may have child thoughts. 
Aristotle was a student of Plato, so you may want to make Aristotle not only a 
child of Philosophy, but of Plato, so that when youôre working with Aristotle, Plato 

is only a thought away. 

  

Figure 41. Example of Parent/Child Relationships 

Notice that when Philosophy and Plato are in Aristotleôs parent zone, their 
relationship (Philosophy is a parent thought of Plato) is shown by the line linking 
the child gate of Philosophy to the parent gate of Plato.  

Clearly, TheBrain is a powerful method of organizing ideas and information. No 
hierarchical file structure can provide as much cross-referenced information at a 
glance. And our example is pretty basicða fully developed brain can hold many 
more relationships and much more information. 
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Navigating Your Brain 

All thoughts can be connectedðdirectly or indirectlyðeven thoughts that may 
seem to have nothing to do with each other can be related through a chain of 
links.  

Letôs look at an example, say, the Queen of England and asparagus. You have a 
thought called Queen of England. One of its child thoughts is Prince of Wales, 
which has a parent thoughtðFamous Princesðthat is also linked to the story of 
the Frog Prince.  

 

The story has another parent thought called Fairy Tales. A sibling of Frog Prince 
is Jack and the Beanstalk.  

 

Jack and the Beanstalk has child thoughts called Giant and Jack. Giant has 
another parent thought called Famous Giants.  

 

Famous Giants has a child thought called Jolly Green Giant. Jolly Green Giant 
has child thoughts named after canned vegetable products, one of which is 

Asparagus. Thus, the Queen of England is connected to asparagus! 

 

Depending on the relationship you create between them, thoughts may be 
closely or distantly related. Thoughts are considered to be closely related when 



 Navigating Your Brain 

TheBrain 12 User Guide 40 

they are linked directly or are siblings. In the default view of the Plex, only close 
thoughts of the active thought are always displayed in the Plex. Thoughts that 
are one additional step (generation) away from the active thought can be 
displayed by expanding the view. See Advanced Navigation and Alternative 
Views on page 160 for information about the different view options. 

Opening a Brain 

When you log into TheBrain 12, and no brain is open, all local, synced or online 
brains will be displayed as thumbnails in the Brains tab, as shown below. This is 
assuming that you have already created one or more brains. Clicking on a brain 
thumbnail opens that brain. Or, hold down the Ctrl key as you click to open a 
brain in a new tab, leaving the Brains tab open. 

 

Figure 42. Example of Four Available Brains on the Brains Tab 

By default, brains are listed according to how recently they have been accessed. 
You can also see the list of brains sorted alphabetically using the Brains tab 
toolbar, shown below. All brains that are locally available are shown first, 
followed by brains that are available online.  
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Figure 43. The Brains Tab Toolbar 

The status of whether each brain is available locally, online, or both is also 
displayed. Each brain in the Brains tab will have an icon appearing in the lower-
right corner of the thumbnail. Right-click on a brain or click on the status icon to 
display a menu of options for that brain, as shown below. The appearance of the 
icon(s) help you identify whether the brain is Local, Synced (local and online) or 
Cloud (Online only). 

 

Figure 44. Icons Indicating Local, Synced, or Cloud 

 

Figure 45. Status Indicator Icons 

Opening a Brain that Doesnôt Appear as a Tab 

If you have a brain from an older version or from a backup, it will not appear in 
the Brains tab until you import it. Click the File menu, then the Import command. 
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Choose the type of file you want to import, then click the Select File button, 
navigate to the file of your choice, then click the Open button when the file is 
selected. Click the Import button after TheBrain has finished converting the 
brain. 

Managing Brains Using the Tabs 

The tabbed interface of the Plex lets you switch instantly between brains or even 
keep the same brain open in multiple Brain tabs or windows. 

To re-open the Brains tab to display the Brain thumbnails, click the + icon to the 

right of the last tab.  

 

Figure 46. Click the + Icon to Open the Brains Tab 

  

There is no limit to the number of brains you can open at once. Each time you 
open a brain it will appear in a separate tab. Switch from brain to brain 
instantaneously by clicking its tab. All tabs and their states are automatically 
saved and restored when you quit and restart. 

Á Float tabs into their own dedicated window by dragging a tab out of TheBrain 
application window. This creates a new Brain application window with just a 
single tab. 

Á Merge tabs into one window by dragging and dropping. Click the tab of one 
Brain window and drag the tab to another open brain, hovering over the tab 

area. Then release the mouse button. 

Á Open the same brain in multiple tabs to view and edit multiple areas at a 
time. This lets you view different areas of your brain at the same time, and, if 
you like, use a different layout in each tab. Note that tabs are simply views 
into the same brain data and changes made in one tab affect all other tabs of 
that brain. 

Á Duplicate tabs. Right-click on a brain tab to duplicate it, showing the same 
content in a new Brain tab. 

Managing Brains Using the Context Menu 

You can right-click any brain in the Brains tab to display the available options. 
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Figure 47. The Context Menu in the Brains Tab 

Tip: Press Ctrl/Cmd + click to open a brain in a new tab from the brains list page.  

 

Opening Content Associated with a Thought 

As you navigate through your brain, the content associated with the active 
thought is displayed in the Content Area. Notes associated with the thought are 
displayed automatically. There are several ways to open an attached file or web 

page:   

Á Click on the link for the attachment in the Content Area. 

Á Click on the attachment icon to the left of the thoughtôs name in the Plex. 

Á Right-click on the thought, click Open Attachment on the context menu, then 

click the attachment of your choice. 

Showing Thought Content on Hover 

By default, the content for the active thought displays in the Content Area. If you 
prefer, you can display content for any thought your mouse pointer hovers over 
by changing the setting. To do so, click the Options menu (TheBrain menu on 
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macOS), click Preferences, click the Behavior tab, then select the ñUpdate 
displayed content on mouse hover or keyboard highlightò check box. Close the 
Preferences window when youôre finished. 

Previewing Thought Content  

Certain types of file attachments are automatically previewed inside of TheBrain. 
These include web pages, images, text, markdown files, JSON, .html files and 
PDFs. Simply click on an attachmentôs tab and its preview will be shown. In the 
example below, Tropical Getaways is the active thought and there are two 

attachments in the Content Areaðan image and a PDF.  

  

You can view multi-page PDFs, web pages, and images as a slide show within 
the Content Area. 

 

Á Click the link for an attachment to open a preview of it in the Content Area. 

Á Click the Next or Previous arrow in the top-right corner of the attachment to 
move back and forth between attachments (or back to the notes in the 
Content Area). 

Á Click the Close button (X) to end the preview and return to the notes. 

Á Click the Open button to open the file outside of TheBrain. 
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Figure 48. Content Area for the Active Thought 

The PDF preview features: 

Á Supported rendering for each OS 

Á Support for very large, multi-page PDFs 

Á Thumbnails of each page, zoom, rotation, search, and printing 

Á All PDF commands can be mapped to a custom keyboard shortcut 

Editing Additional Notes 

Adding additional attachments to a thought, such as .md and .txt files will enable 
you to also edit these attachments the same as you would a brain note.  

Pins 

As you saw if you went along on the Guided Tour of TheBrain earlier, pins are 
shortcuts to thoughts to which you want quick access. They appear at the top of 
the Plex, just below TheBrain toolbar. No matter where you are in your brain, the 
pins remain visible. 
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Figure 49. Pins 

To create a pin: 

Á Right-click the thought for which you want to create a pin, then click Create 
Pin on the context menu  

 

Figure 50. Creating Pins 

To remove a pin: 

Á Right-click the pin or on a thought that has a pin, then click Remove Pin on 
the context menu 
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Removing a pin does not remove or delete the associated thought; it deletes 
only the reference to it at the top of the Plex. 

To use a pin to link thoughts: 

Á Drag from one of the thought gates to the pin, or 

Á Move your mouse pointer over a pinned thought and gates will appear; drag 
from one of these gates to the thought you want to link 

Activating Recent Thoughts: The Past Thought List 

TheBrain keeps a running breadcrumb trail of your thoughts based on activation 
and displays it in the Past Thought List. You can think of the Past Thought List as 
the visual representation of the phrase, ñtrain of thoughtòða scrollable list of 
thoughts in the order you activated them. The Past Thought List is displayed at 
the bottom of the Plex window. 

Clicking on any thought in the Past Thought List activates that thought. Also, 
when a new thought is created it appears in the Past Thought List immediately.  

 

Figure 51. Past Thought List 

The left and right arrows to the left of the Past Thought List enable scrolling to 
see items that donôt fit on the display.  

The most recently activated thought (the currently active thought) appears at the 
right end of the list. 

To use a thought in the Past Thought List to link thoughts: 

Á Drag from one of the thought gates to one of the thoughts in the Past 

Thought List, or 

Á Move your mouse pointer over a thought in the Past Thought List and gates 
will appear; drag from one of these gates to the thought you want to link 



 Navigating Your Brain 

TheBrain 12 User Guide 48 

In the example below, Tropical Vacations is going to become a parent of Airline 
Rewards; the mouse is being dragged from the child gate of Tropical Vacations 
to Airline Rewards in the Past Thought List. 

 

Figure 52. Creating a Link using the Past Thought List 

Using the Back and Forward Buttons: 

Á In addition to the Past Thought List, you can also use the Back and Forward 
buttons, located near the top of the Window, to quickly retrace your steps; 

these buttons work just like they do in a web browser 

 

Á Click the Back button to go back to the last active thought 

Á Once you have clicked the Back button, the Forward button can be used to 
re-activate the thought you came from 

 

Back and Forward Mouse Buttons: The back and forward buttons available on 
some mice (typically on the left side of the mouse near where you place your thumb) 
may be used to navigate backward and forward in your brain. These mouse buttons 
perform the same navigation as the Back and Forward buttons in the Brain toolbar, 
shown above. 

Searching a Brain 

Instant Activation 

TheBrain includes powerful search capabilities. The Search box is in the top-right 
area of the application. 
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Figure 53. The Search Box 

The term ñinstant activationò refers to TheBrainôs ability to quickly find whatever 
youôre searching for and activate the related thought. You can easily scan the 
search results as you type in the Search box. There's no need to click in the 
Search box, your cursor is always there by default, unless you are actively typing 
in the Content Area or another field. 

A Content Area Preview will automatically appear for each choice you highlight. 

To activate one of these results, click it with your mouse or use the up-arrow, 
down-arrow, page up, and page down keys on the keyboard then press the 
Enter key.  

 
Figure 54. Instant Activate Finds Matches Based on Thought 

Names, Labels, Notes, and Attachments 

 

Accents are ignored when matching thought names. Also, when two or more 
matches with the same name are found, the names of their parent or jump 
thoughts are also displayed so you can differentiate them. 

You can search for thoughts by typing the first letter(s) of separate words and the 
letters can be in any sequence; for example, to find the ñFamily and Friendsò 
thought you could type ñfa fr,ò or ñfr fa,ò or ñfa and fri.ò 
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Figure 55. Use First Letters of Separate Words for Instant Activate 

 

Attachments and note search matches are identified with a yellow piece of paper 

icon for notes and a paper clip icon for Attachments. 

 
Figure 56. Search Results 

When you do a search, the results are sorted with results that match thought 
names first, then notes, then attachments. Within the thought name matches, 
they are ranked in groups: 

Á Exact Matchesðwhere the entire name of the thought matches the entire 
query 

Á Starting Matchesðwhere the entire query occurs at the start of the thought 
name 

Á Continuous Matchesðwhere the entire query occurs anywhere in the 
thought name 

Á Matchesðwhere every term in the query occurs somewhere in the thought 
name 
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Within each group, thoughts that have been activated in the last 30 days will be 
shown first, ordered with the most recently activated first. Thoughts that have not 
been activated within 30 days are sorted alphabetically. 

 

Searching within Attachments 

 Your searches automatically include matches based on the contents of 
attachments. If the text youôre searching for exists within documents including 
PDFs, Word, Excel, PowerPoint and many other file formats, the documents 

containing the text will be found. 

 

On Windows, TheBrain utilizes Windows Desktop Search to provide search 
results to Brain notes and file attachments.  

 

TheBrain integrates with Spotlight on macOS to provide search results from 
within file attachments. No setup or additional steps are required to enable this 
functionality. 

 

 

For searches in TheBrain to return accurate results, Windows Desktop Search 
or Spotlight will need to have access to the location where your brains are 
being stored. For more information on your brain storage, see page 90. 

Using the Search Box to Search the Web 

Say youôre searching for something and come up with no hits. For example, 
youôre on a neighborhood committee and youôve volunteered to look into an issue 
with squirrels. You type ñsquirrelsò in the Search box. No results? Press the F4 

key to search the web. 
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Figure 57. Search-Engine Choices 

Á Click the drop-down arrow if you want to select a different search engine, 
then click the Search button to begin searching the web based on what 
youôve typed. 

Á When you find a site you like, you can add it to any thought in the usual way. 
The Web Search box will close automatically after you click the Search 
button. 

To modify, add, or reset search-engines: 

Á Click the Edit button in the Web Search box. 
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Figure 58. Editing Search-Engine URLs 

To customize the search-engine choices: 

Á Click and edit any URL string to customize it, or 

Á Click the Add New button to enter a name that isnôt already in the list, or 

Á Click the Reset button to return to TheBrainôs default choices 

Click the OK button to save your customizations or click the Cancel button to 
close the box without making changes. The original Web Search box will still be 
open, still showing the text you were searching for. 

Additional Search Functionality 

Search has several additional capabilities that are automatically enabled. 

Á You can find and execute commands from the Search box. To begin, type a 
forward slash (/) in the Search box. An alphabetical list will appear. The list 

will be fine-tuned to match what you type. 
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Figure 59. Executing a Command from the Search Box 

Á External attachments are included in search results 

Á Search using acronyms (ex. find "New York Stock Exchange" by typing 

"nyse") 

Á Search for thoughts starting with punctuation. You may use this as a shortcut 
to provide fast access to thoughts that you always start with a certain type of 
punctuation. For example, you could use this for people (@Mike, @Sally, 

@Debbie, etc.) or projects (#Ridgeline, #Palmdale, #Westly, etc.) 

 

Figure 60. Search Results for Both Internal and External Attachments 
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Customizing Your Brainôs Environment 

You may choose to use your brain just as itôs offered ñout of the boxò or you may 
choose to change some of the environmental settings to suit your personal 
preferences. 

TheBrainôs Default Settings 

Without making any changes, hereôs what your brain looks like: 

Á The area where your thoughts appear (the Plex) will be the color and design 
of one of TheBrainôs ñThemes.ò The initial theme is randomly selected and 
you can change it at any time. 

Á The left half of TheBrain window will display your thoughts and the right half 
of the window will display the ñContent Areaò which holds notes and any other 
items you will attach to your thoughtsðfiles, web pages, Events, etc. 

Á Your thoughts will be displayed in ñNormalò view, meaning that you will see 

only the direct parents, children, jumps, and siblings of the active thought. 

 

Figure 61. TheBrain Window with Default Settings 

Using Smart-Splitter to Arrange TheBrain Window 

The smart-splitter controls let you manage where the Plex and Content Area 
display relative to each other in the Brain window.  
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Figure 62. Smart-Splitter 

Á Click the individual left- and right-arrows (or up- and down-arrows if the 
window is in ñover-and-underò mode) to maximize the area the arrow is 
pointing towards (either the Plex or the Content Area). 

Á Click the double-headed arrow icon to toggle the Plex to the right or left side 
of the Content Area. 

Á Click on the two-arrow icon that forms a box to toggle between seeing the 
Plex and Content Area "side-by-side" or ñover-and-under.ò 

Á You can also point at the border between areas and click and drag when the 
double-headed arrow appears to move the border. 

Moving Thoughts in the Plex 

When the default settings are in use and the Plex is in ñNormalò view, you can 
move the thoughts in the Plex up or down, vertically, by dragging (up or down) in 

any blank area of the Plex background. 
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Figure 63. Dragging the Plex Vertically 

Resizing Thoughts in the Plex 

The Plex is the heart and soul of TheBrain. You can change the size of thoughts 
in the Plex by using TheBrain toolbar or your keyboard and mouse. 

To change the size of thoughts using the toolbar: 

Á Click the AA button to activate the slider, then click and slide the bar up or 
down to grow or shrink the size of your thoughts. 
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 Figure 64. Resizing Thought Size with the Slider 

To change the size of thoughts using the keyboard, mouse, or trackpad: 

Á Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and scroll up or down 
on your mouse wheel or trackpad while your mouse pointer is in the Plex. 

 

Figure 65. Resizing with the Mouse or Trackpad 

Á Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and press - to make 
thoughts smaller or + to make thoughts larger. 

 

Figure 66. Resizing with the Keyboard 
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Á Pinch to zoom on a macOS Trackpad. 

 
Figure 67. Resizing on a Trackpad 

Customizing a Brainôs Appearance 

Selecting a Theme 

The Themes feature lets you choose from many built-in designs to customize the 
look of your brain, including the appearance of the Plex and notes in the Content 
Area. You can change many of the default colors and the style of notes 
associated with the Theme, then save the look of your brain as a new Theme. 
This lets you quickly switch from one saved Theme to another. 

 

Figure 68. Sample Themes 
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To select a Theme: 

1. Either click the Options menu in TheBrain toolbar (TheBrain menu on 
macOS) or right-click any blank space in the Plex. 

2. Click the Brain Theme command. 

 

Figure 69. Accessing the Brain Theme Dialog Box 

In the Brain Theme box, youôll see a scrollable list of available themes in the left 
panel and Colors and Options tabs in the right panel. Click on any Theme to 
see how it looks in the Plex. 

 

Figure 70. The Brain Theme Dialog Box 
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Customizing a Themeôs Colors 

 

Have the Brain Theme box open when you want to customize a Theme (right-
click a blank area of the Plex, then click the Brain Theme command). 

The default colors for virtually all items in the Plex vary based on the selected 
Theme. The current color for each item is shown in the circle to the right of the 
itemôs description. Scroll through the list in the Colors tab to get an idea of all of 
the items that can be changed.  

To change the colors in the selected Theme: 

1. Click the item whose color you want to change to display your choices. 

 

Figure 71. Color Choices in the Colors Tab 

2. Click the color of your choice, click outside of the box of colors to close it, 
then click Close (X) (or press Esc) to close the Brain Theme box. 












































































































































































































































































































































































































